
SUSE® Linux Enterprise Desktop proporciona las herramientas que necesitan los usuarios de Linux* en sus tareas
cotidianas. Incluye una interfaz gráfica de usuario fácil de utilizar (el escritorio KDE) que se comunica con el
sistema Linux subyacente para acceder a archivos, carpetas y programas y gestionarlos. SUSE Linux Enterprise
Desktop proporciona una suite de aplicaciones integrada que satisface todos los requisitos profesionales para
llevar a cabo tareas del ámbito empresarial. También se incluye la suite OpenOffice.org, que permite editar y
guardar archivos en numerosos formatos. Dado que esta suite de oficina está disponible para distintos sistemas
operativos, podrá utilizar los mismos datos en diferentes plataformas informáticas.

Procedimientos iniciales
Cuando se inicia el sistema, normalmente se le solicita que
introduzca el nombre de usuario y la contraseña. Si no ha
realizado la instalación del sistema usted mismo, consulte
con el administrador del sistema para que le proporcione
esos datos.

Tras iniciar sesión en KDE por primera vez, verá el escritorio
KDE, que muestra los siguientes elementos básicos:

Iconos del escritorio: haga clic en un icono del escritorio
para acceder al programa o la aplicación que tenga asocia-
dos. Haga clic con el botón derecho para abrir un menú
contextual que permite mover o copiar los iconos o realizar
otras acciones con ellos.

Menú contextual del escritorio: haga clic con el botón
derecho en una área vacía del escritorio para acceder a un
menú contextual que permite crear objetos nuevos, como

Guía de inicio rápido de
SUSE® Linux Enterprise Desktop 10
con KDE

NOVELL® QUICK START CARD

1



archivos, carpetas o marcadores, configurar el aspecto del
escritorio, ejecutar aplicaciones o finalizar la sesión.

Panel de KDE: por defecto, el panel del escritorio KDE
incluye las siguientes áreas (de izquierda a derecha): botón
del menú principal, lanzador rápido, vista previa del escrito-
rio, barra de tareas y bandeja del sistema. Puede añadir o
quitar iconos en el panel y personalizar tanto su aspecto
como su ubicación. Si hace clic en la flecha del extremo
derecho, se ocultará el panel. Si coloca el puntero del ratón
sobre un icono del panel, aparecerá una descripción breve.

Botón del menú principal: haga clic en el icono del
extremo izquierdo del panel para acceder a un menú que
permite ejecutar todos los programas, las herramientas y
las aplicaciones del sistema. La estructura de menú orientada
a las funciones permite localizar fácilmente la aplicación
adecuada para cada finalidad, incluso si todavía no conoce
los nombres de las aplicaciones.

Lanzador rápido el lanzador rápido incluye iconos más
grandes, que son accesos directos a programas, carpetas o
funciones que se utilizan con frecuencia, como el navegador
de Internet, la carpeta personal o el Centro de ayuda en
línea.

Vista previa de escritorios: entre el lanzador rápido y
la barra de tareas, se encuentra una vista previa en
miniatura que muestra los escritorios virtuales. SUSE Linux
Enterprise Desktop permite organizar los programas y las
tareas en varios escritorios, lo que reduce el número de
ventanas que se deben organizar en la pantalla (Section
“Uso de escritorios virtuales”). Para cambiar de un escritorio
a otro, haga clic en uno de los símbolos de la vista previa.

Barra de tareas: por defecto, todas las aplicaciones ini-
ciadas y las ventanas abiertas se muestran en la barra de
tareas, lo que permite acceder a cualquier aplicación, sea
cual sea el escritorio activo en ese momento. Haga clic para
abrir la aplicación. Haga clic con el botón derecho para ac-
ceder a opciones que permiten mover, restaurar o minimizar
la ventana.

Bandeja del sistema: en el extremo derecho del panel
se encuentran normalmente iconos más pequeños, entre
los que se incluyen el reloj del sistema, que muestra la fecha
y la hora, el control de volumen y otras aplicaciones de
ayuda.

Inicio de programas
Para ejecutar un programa en SUSE Linux Enterprise Desk-
top, haga clic en el icono del menú principal del panel o
pulse Alt + F1 para abrirlo y examinar los submenús. Haga
clic en una entrada para iniciar el programa correspondi-
ente.

Si conoce el nombre de una aplicación y no está seguro de
cómo iniciarla desde el menú principal, puede utilizar la

función de búsqueda de ese menú. Escriba parte del nombre
de la aplicación en el campo de búsqueda sin pulsar después
la tecla Enter. Si la aplicación está instalada en el sistema,
se destacará en el menú principal la estructura de menús
que conduce a ella.

Personalización del escritorio
El usuario puede cambiar el aspecto y el funcionamiento
del escritorio KDE para que se ajuste a sus preferencias y
necesidades.

Cambio de elementos individuales del
escritorio
En las siguientes secciones, encontrará algunos ejemplos
de cómo cambiar elementos individuales del escritorio.

Adición de iconos de programa al escritorio
Para crear un enlace a una aplicación y colocarlo en el es-
critorio, haga lo siguiente:

1. Haga clic en el botón del menú principal.
2. Acceda al programa que desee.
3. Haga clic con el botón izquierdo en la entrada de menú,

arrástrela hasta el escritorio y suelte el botón del ratón.
4. Seleccione Link Here (Enlazar aquí) en el menú contex-

tual que se muestra y coloque el icono donde quiera.
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Para suprimir un icono del escritorio, haga clic en él con el
botón derecho y seleccione Move to Trash (Mover a la pa-
pelera).

Personalización del panel de KDE
Puede personalizar el panel de KDE para ajustarlo a sus
preferencias añadiendo, suprimiendo o moviendo iconos
o cambiando el aspecto general del panel.

1. Para añadir o quitar iconos, haga clic con el botón
derecho en una zona vacía del panel. Se mostrará un
menú contextual.

2. Para añadir una aplicación, haga clic en Add Application
to Panel (Añadir aplicación al panel) y seleccione la
aplicación que quiera en una de las categorías del sub-
menú.

3. Para añadir un applet (miniprograma), haga clic en Add
Applet to Panel (Añadir applet al panel) y seleccione el
applet que desee en el cuadro de diálogo que se abre.
Haga clic en Add to Panel (Añadir al panel) para insertar
el applet en el panel.

4. Para quitar iconos del panel, seleccione Remove from
Panel → Applications (Quitar del panel - Aplicaciones)
o Remove from Panel → Applet (Quitar del panel - Ap-
plet) y elija el icono que quiera quitar.

5. Si quiere cambiar el aspecto o el comportamiento
generales del panel, seleccione Configure Panel (Config-
urar panel) en el menú contextual. Se mostrará un
cuadro de diálogo donde podrá definir ajustes adi-
cionales.

Cambio del fondo de escritorio
Puede cambiar el color del fondo del escritorio o seleccionar
una imagen para usarla como fondo. Dado que KDE admite
escritorios virtuales (consulte el Section “Uso de escritorios
virtuales”), puede aplicar estos cambios a uno o a todos los
escritorios virtuales.

1. Haga clic con el botón derecho en un espacio vacío del
escritorio y seleccione Configure Desktop (Configurar
escritorio). Se abrirá un cuadro de diálogo de configu-
ración.

2. En Settings for Desktop (Ajustes para el escritorio), elija
los escritorios virtuales a los que se deben aplicar los
cambios.

3. Si quiere utilizar una imagen distinta en el fondo, haga
clic en Picture (Imagen) y seleccione una de las que se
proporcionan en la lista. Para utilizar una imagen per-
sonalizada, haga clic en el botón de carpeta que se
muestra debajo de la lista y seleccione una imagen del
sistema de archivos.

4. Haga clic en Slide Show (Presentación de diapositivas)
para utilizar varias imágenes que se muestren en modo
de presentación de diapositivas.

5. Si no quiere incluir una imagen en el fondo, haga clic
en No picture (Sin imagen).

6. En el grupo Options (Opciones), haga clic con el botón
izquierdo debajo de Colors (Colores) para seleccionar
el color del fondo. Si quiere definir un fondo con varios
colores, elija una opción en Colors (Colores) que no sea
Single Color (Un color) y haga clic en el botón derecho
debajo para seleccionar un segundo color.

7. Haga clic en Apply (Aplicar) y después en OK (Aceptar)
para cerrar el cuadro de diálogo de configuración.

Uso del Centro de control de KDE
Además de cambiar elementos individuales del escritorio,
KDE permite personalizarlo en gran medida. El Centro de
control de KDE incluye ajustes adicionales para cambiar el
aspecto y el comportamiento del escritorio. En él, puede
cambiar las fuentes, la configuración del teclado y del ratón,
los ajustes regionales y de idioma o los parámetros que
definen el uso de Internet y de la red, entre otras cosas.

Inicie el Centro de control desde el menú principal seleccio-
nando Personal Settings (Ajustes personales) o pulse Alt +
F2 y escriba kcontrol.
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La barra lateral proporciona diferentes categorías, cada una
de las cuales incluye un subconjunto de ajustes. Para tener
una idea de las numerosas posibilidades, haga clic en un
icono de categoría y explore las opciones que se proporcio-
nan.

Para acceder a una descripción general de todas las cate-
gorías, cambie a la vista de árbol. Para cambiar la vista, se-
leccione View → Mode → Tree View (Ver - Modo - Vista de
árbol).

Al hacer clic en un elemento, los ajustes correspondientes
aparecen a la derecha. Modifique los ajustes de modo que
se ajusten a sus necesidades. Los cambios no surtirán efecto
hasta que haga clic en Apply (Aplicar). Para restablecer to-
dos los elementos de la página a los valores por defecto,
haga clic en Default (Por defecto). Para poder realizar tareas
en algunas áreas del Centro de control, es preciso contar
con permisos de administrador del sistema (también cono-
cido como Root).

Uso de escritorios virtuales
El entorno de escritorio permite organizar los programas y
las tareas en varios escritorios virtuales. Si suele ejecutar
muchos programas a la vez, esta posibilidad reduce el
número de ventanas que se deben organizar en la pantalla.
Puede, por ejemplo, utilizar un escritorio para tareas rela-
cionadas con el calendario y el correo electrónico y otro
para aplicaciones de procesamiento de textos o de gráficos.

Desplazamiento de una aplicación a un escritorio virtual
Puede mostrar una aplicación que se esté ejecutando en
uno o en todos los escritorios virtuales, así como moverla
de un escritorio a otro.

1. Abra la aplicación.
2. Haga clic con el botón derecho en la barra de título de

la aplicación.
3. Haga clic en To Desktop (A escritorio).
4. Seleccione el escritorio donde quiera colocar la apli-

cación.
5. Para cambiar de un escritorio a otro, haga clic en la

vista previa del escritorio que desee en el panel.

Adición de otros escritorios virtuales
Puede que necesite más escritorios de los que se proporcio-
nan por defecto. Para añadir otros escritorios:

1. Haga clic con el botón derecho en la vista previa de
escritorios del panel y seleccione Configure Desktops
(Configurar escritorios). Se mostrará un cuadro de
diálogo donde puede aumentar o reducir el número
de escritorios virtuales. También puede cambiar los
nombres de los escritorios por defecto.

2. Haga clic en OK (Aceptar) para aplicar los cambios y
cerrar el cuadro de diálogo de configuración.

3. Si quiere que en la vista previa aparezcan los nombres
de los escritorios en lugar de los números, pulse con el
botón derecho en la vista previa de escritorios y selec-
cione Pager Options → Desktop Name (Opciones de
paginador - Nombre de escritorio).

Uso de Konqueror
Konqueror es un navegador Web, un gestor de archivos,
un visor de documentos y un visor de imágenes todo en
uno. Como gestor de archivos, permite ver, gestionar y crear
archivos, así como organizar en general el sistema de
archivos del modo que quiera.

Inicie Konqueror como gestor de archivos haciendo clic en
el icono del panel que simboliza una casa. Konqueror
mostrará el contenido del directorio personal del usuario.

Ventana principal de Konqueror
La ventana principal de Konqueror consta de los siguientes
elementos:
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Barra de menús la barra de menús incluye elementos
para acciones como copiar, mover o suprimir archivos,
cambiar de vista, iniciar herramientas adicionales, definir
ajustes y obtener ayuda.

Barra de herramientas: la barra de herramientas ofrece
acceso rápido a las funciones usadas con frecuencia a las
que también se puede acceder desde el menú. Si coloca el
puntero sobre un icono, aparece una descripción breve.

Barra de ubicación: la barra de ubicación muestra la vía
al directorio o archivo en el sistema de archivos. Puede in-
troducir la vía a un directorio escribiéndola directamente,
o bien haciendo clic en uno de los directorios del campo
de visualización. Para suprimir el contenido de la barra de
ubicación, haga clic en el símbolo negro con una X blanca
que se encuentra a la izquierda. Después de escribir una
dirección, pulse Enter.

Panel de navegación: puede mostrar u ocultar el panel
de navegación de la izquierda pulsando F9. El panel de
navegación muestra la información en una vista de árbol.
Determine el contenido que desea ver haciendo clic en uno
de los símbolos de la pestaña a la izquierda del panel de
navegación. Si coloca el puntero del ratón sobre un icono,
aparece una descripción breve.

Campo de visualización: el campo de visualización
muestra el contenido del directorio o archivo seleccionado.
En el menú View (Ver), seleccione entre los distintos modos
de visualización para mostrar el contenido, como Icon View
(Vista de iconos), Tree View (Vista en árbol) o Detailed List
View (Vista de lista detallada). Si hace clic en un archivo,
Konqueror muestra una vista previa del contenido o carga
el archivo en una aplicación para procesarlo. Si mantiene
el puntero del ratón sobre el archivo, Konqueror muestra
una sugerencia de herramienta con información detallada
sobre el archivo, como el propietario, los permisos o la
fecha de modificación más reciente.

Gestión de archivos y carpetas con Konqueror
Para llevar a cabo acciones como copiar, mover o suprimir
archivos, necesitará los permisos adecuados para las car-
petas y archivos implicados en la acción.

Para copiar o mover un archivo o carpeta, lleve a cabo el
siguiente procedimiento:

1. Para seleccionar uno o varios archivos y carpetas en
Konqueror, pulse Ctrl y haga clic en los elementos cor-
respondientes.

2. Haga clic con el botón derecho y seleccione Copy
(Copiar) o Cut (Cortar) en el menú contextual.

3. Acceda a la carpeta de destino donde quiera insertar
el objeto. Haga clic con el botón derecho en la carpeta
de destino y seleccione Paste (Pegar). El objeto se
copiará o moverá a esa carpeta.

También puede utilizar la técnica de arrastrar y soltar para
copiar o mover los objetos. Al soltar el objeto, se le pregun-
tará si se debe mover o copiar.

Para suprimir un archivo o una carpeta, haga clic en el ob-
jeto con el botón derecho y seleccione Move to Trash
(Mover a la papelera) en el menú contextual. El objeto se
mueve a la papelera, donde puede recuperarlo si es preciso
o suprimirlo de forma permanente.

Navegación en Internet con Konqueror
Si quiere utilizar Konqueror como navegador Web, basta
con que escriba la URL en la barra de ubicación. Al igual
que Firefox, en Konqueror también se utiliza la navegación
con pestañas, lo que significa que puede cargar una página
en segundo plano mientras ve otra. Para abrir una pestaña
vacía en Konqueror, pulse Ctrl + Shift + N y escriba una
nueva URL. De igual forma, puede hacer clic con el botón
derecho en el sitio Web que esté viendo y seleccionar Open
in New Tab (Abrir en una nueva pestaña). Haga clic con el
botón derecho en una pestaña para mostrar opciones
relacionadas que permiten volver a cargar, duplicar o cerrar
la pestaña.
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También puede utilizar marcadores para sus sitios Web fa-
voritos (así como para archivos o carpetas). Puede añadir
y gestionar los marcadores desde el menú Bookmarks
(Marcadores).

Navegación en Internet con Firefox
Además de Konqueror, SUSE Linux Enterprise Desktop in-
cluye también el navegador Web Firefox. Para iniciar Firefox,
pulse Alt + F2 e introduzca firefox.

Firefox, que combina las tecnologías Web más recientes,
presenta funciones tales como pestañas, bloqueo de ven-
tanas emergentes y gestión de descargas e imágenes. Su
facilidad para acceder a distintos motores de búsqueda le
ayudará a encontrar la información que necesita. Escriba
una URL en la barra de ubicación para empezar a navegar.
Para abrir una pestaña vacía en Firefox, pulse Ctrl + T y es-
criba una nueva URL. Para abrir un enlace en una pestaña
nueva, haga clic en él con el botón central del ratón. Haga
clic con el botón derecho en la pestaña para acceder a más
opciones. Puede crear una pestaña nueva, recargar una o
todas las existentes y cerrarlas. También puede cambiar la
secuencia de las pestañas arrastrándolas y soltándolas en
la posición que desee.

Búsqueda de información con Firefox
Firefox ofrece dos opciones de búsqueda distintas: puede
buscar información en Web o buscar palabras clave en la
página Web activa.

1. Para iniciar una búsqueda en Web con el motor de
Google, escriba las palabras clave de la búsqueda en la
barra de búsqueda integrada que se muestra a la
derecha de la barra de ubicación y pulse Enter. Los re-
sultados aparecerán en la ventana.

2. Para utilizar un motor de búsqueda distinto, haga clic
en el icono de la G que se muestra en la barra de
búsqueda para desplegar una lista de motores de
búsqueda.

3. Haga clic en el motor que prefiera y pulse Enter para
comenzar la búsqueda.

Para buscar palabras clave en la página Web activa, pulse
Ctrl F y se abrirá una barra de búsqueda en la parte inferior
de la ventana. Escriba la palabra clave que quiera buscar y
utilice los botones que se incluyen debajo de la barra para
buscar en distintas direcciones o para resaltar todas las co-
incidencias del texto.

Descargas de archivos de Web
Si descarga un archivo con Firefox, el administrador de
descargas se inicia y guarda el archivo en la carpeta que
esté configurada en las preferencias. Por defecto, el escrito-
rio es la carpeta de destino donde se almacenan los archivos
descargados. Firefox muestra las descargas finalizadas en
un cuadro de diálogo.

Puede abrir los archivos descargados directamente desde
esa ubicación. Para limpiar el historial de archivos descarga-
dos, haga clic en Clean Up (Limpiar).

Configuración de las preferencias de Firefox
Para cambiar la carpeta de descarga por defecto o activar
o modificar la función de bloqueo de ventanas emergentes,
haga clic en Edit → Preferences (Editar - Preferencias).

Desde esa ubicación, puede configurar otros muchos ajustes
como el aspecto, el idioma, la privacidad y las opciones de
pestañas. Basta con que haga clic en los iconos y defina las
opciones de cada página para que se ajusten a sus prefer-
encias. Haga clic en Close (Cerrar) para aplicar los cambios.
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Gestión de contraseñas con KWallet
Si selecciona la opción que permite recordar las contraseñas
de las aplicaciones de KDE después de escribirlas por
primera vez (por ejemplo, para la cuenta de correo elec-
trónico), se inicia el asistente de KWallet por defecto.
KWallet es una herramienta de gestión de contraseñas que
puede recopilar todas las contraseñas y almacenarlas en un
archivo cifrado.

Para activar KWallet, seleccione Basic Setup (Configuración
básica) y haga clic en Next (Siguiente). Seleccione Yes, I wish
to use the KDE wallet to store my personal information (Sí,
deseo usar el sistema de carteras de KDE para almacenar
mi información personal) y escriba una contraseña, la cual
pasará a ser su contraseña maestra para abrir KWallet. Esta
contraseña no se puede recuperar si la olvida. Haga clic en
Finish (Finalizar) para cerrar el asistente. Después de esta
configuración inicial, podrá abrir el sistema de carteras en
cualquier momento para ver, buscar o crear entradas.
Normalmente, no será necesario que escriba manualmente
la entrada. Si KDE detecta que un recurso requiere autenti-
cación, se inicia KWallet automáticamente y se le solicita la
contraseña de KWallet.

Correo electrónico y calendario
Para leer y gestionar los mensajes de correo y las citas en
SUSE Linux Enterprise Desktop, puede utilizar Kontact como
herramienta de gestión de información personal (PIM, Per-
sonal Information Management). Kontact combina aplica-
ciones de KDE como KMail, KOrganizer y KAddressBook en
una sola interfaz. De este modo, podrá acceder fácilmente
al correo electrónico, el calendario, la libreta de direcciones
y otras funciones de herramientas PIM.

Inicio de Kontact por primera vez
Para iniciar Kontact, pulse Alt + F2 e introduzca kontact.
Para acceder a uno de los componentes, haga clic en el
icono correspondiente en la barra lateral izquierda.

Antes de enviar y recibir correo, debe configurar la cuenta
de correo electrónico.

1. Haga clic en el icono Mail (Correo) para seleccionar a
continuación Settings → Configure KMail (Ajustes -
Configurar KMail).

2. En el cuadro de diálogo de configuración, haga clic en
Accounts (Cuentas). Ahí puede configurar los ajustes
para los mensajes entrantes y salientes.

3. Para los mensajes entrantes, haga clic en la pestaña
Receiving (Recepción) y después en Add (Añadir). Selec-
cione el tipo de cuenta adecuado y escriba los detalles
en el siguiente cuadro de diálogo.

4. Haga lo mismo para los mensajes salientes en la pestaña
Sending (Envío). Si no está seguro de los ajustes o de
los elementos que debe seleccionar, consulte con su
proveedor de servicios de Internet o con el admin-
istrador del sistema.

Mensajería instantánea con Kopete
Kopete es una aplicación de mensajería en línea que permite
que varias personas conectadas a Internet charlen unas con
otras. Kopete admite actualmente todos los protocolos de
mensajería comunes: ICQ, MSN, Yahoo, SMS, Jabber, IRC y
GroupWise Messenger. Para poder utilizar la mensajería in-
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stantánea, debe estar registrado con un proveedor que
ofrezca ese servicio.

Para iniciar Kopete, pulse Alt + F2 e introduzca kopete.
Cuando se inicia Kopete por primera vez, se muestra un
asistente de configuración que le ayuda a crear un perfil
de usuario.

En primer lugar, seleccione el servicio con el que se haya
registrado y haga clic en Continue (Continuar). A contin-
uación, introduzca los datos de usuario que haya recibido
al registrarse en el servicio de mensajería: un ID de usuario,
una contraseña y el nombre y puerto del servidor. Complete
la configuración de la cuenta de mensajería haciendo clic
en Finish (Finalizar).

Añada contactos con los que desee conversar haciendo clic
en File → Add Contact (Archivo - Añadir contacto). Se
mostrará un nuevo asistente que le ayudará con la creación.
Sin embargo, debe estar en línea y conectar Kopete con el
servicio de mensajería seleccionado para añadir un contacto
a la lista.

Para iniciar una conversación, haga clic en el contacto que
desee y escriba un mensaje en la parte inferior de la ven-
tana. Pulse Enter para enviar el mensaje. La parte superior
de la ventana muestra los mensaje que haya enviado y
recibido.

Sincronización y uso compartido de
datos
Novell iFolder® permite gestionar y actualizar los archivos
desde cualquier ubicación realizando un seguimiento de
los cambios y sincronizándolos en todas las estaciones de
trabajo. Para utilizar la función de sincronización, cargue
una carpeta del sistema de archivos a un servidor de iFolder.
El cliente de iFolder que se ejecute en el equipo local podrá
acceder a los datos del servidor y sincronizarlos. También
puede compartir una carpeta en el servidor de iFolder y
otorgar a otros usuarios permisos para acceder a ella.

Antes de poder usar iFolder, debe estar registrado como
usuario autorizado en el servidor de iFolder. Para iniciar el
cliente de iFolder, pulse Alt + F2 e introduzca ifolder.
Cuando inicie iFolder por primera vez, se abrirá un asistente
donde deberá introducir el nombre del servidor de iFolder,
su nombre de usuario y su contraseña para ese servidor.
Para conectar automáticamente con el servidor cada vez
que se inicie iFolder, active la opción Remember Password
(Recordar contraseña). Tras esta configuración inicial, el
cliente de iFolder podrá establecer la conexión.

Carga y sincronización de carpetas
Sólo puede sincronizar archivos o cargar nuevas carpetas
cuando esté conectado a un servidor de iFolder.

1. Ejecute iFolder e inicie sesión si se le solicita. Haga clic
en el icono de iFolder del panel para abrir la ventana
principal.

2. Haga clic en Upload a folder (Cargar una carpeta) y, en
el siguiente cuadro de diálogo, acceda a una carpeta
existente o haga clic en Create Folder (Crear carpeta)
para crear una nueva.

3. Cuando la carpeta adecuada aparezca en la parte
derecha del cuadro de diálogo, selecciónela y haga clic
en OK (Aceptar) para cargarla al servidor de iFolder.

4. Cuando se haya cargado la carpeta, aparecerá en la lista
de carpetas iFolder disponibles. A partir de ese momen-
to, el cliente sincronizará el contenido de la carpeta
según el intervalo de tiempo por defecto. Para sin-
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cronizarlo manualmente, haga clic en Synchronize Now
(Sincronizar ahora).

Uso compartido de carpetas iFolder
Para otorgar a otros usuarios permisos de acceso a una
carpeta iFolder:

1. Seleccione la carpeta iFolder adecuada y haga clic en
Share with (Compartir con). En el siguiente cuadro de
diálogo, haga clic en la pestaña Sharing (Uso compar-
tido) y en Add (Añadir) para ver una lista de los usuarios
disponibles.

2. Seleccione los usuarios con los que quiera compartir la
carpeta en la lista de la izquierda y haga clic en Add
(Añadir) para incluirlos en la lista de la derecha.

3. Cuando la lista de la derecha incluya todos los usuarios
que desee añadir, haga clic en OK (Aceptar). La pestaña
Sharing (Uso compartido) mostrará los usuarios que se
hayan seleccionado para compartir la carpeta.

4. Para modificar el acceso de un usuario, haga clic en su
nombre y después en Access (Acceso).

5. Seleccione los derechos que desee otorgar al usuario
y haga clic en OK (Aceptar) para cerrar el cuadro de
diálogo.

6. Para aplicar los cambios, haga clic en Close (Cerrar).
Cuando los usuarios que se hayan añadido inicien sesión
en iFolder, recibirán una notificación que indica que
han sido seleccionados para compartir una carpeta.

Para cerrar la ventana de iFolder, seleccione iFolder→ Close
(iFolder - Cerrar). De esta forma, el cliente de iFolder sigue
ejecutándose y permite realizar otras sincronizaciones de
archivos en segundo plano. Si finaliza la sesión activa de
KDE en ese momento, iFolder se iniciará automáticamente
cuando vuelva a iniciar sesión e intentará establecer de
nuevo la conexión con el servidor de iFolder. Para finalizar
la sesión y terminar la conexión con el servidor de iFolder,
seleccione iFolder → Exit (iFolder - Salir). De esta forma,
iFolder deja de realizar el seguimiento de los cambios y el
icono del programa desaparece del panel.

Inicio de OpenOffice.org
El paquete de aplicaciones ofimáticas OpenOffice.org ofrece
un conjunto completo de herramientas de oficina, incluidas
aplicaciones de procesamiento de texto, hojas de cálculo,
presentaciones, dibujo de vectores y componentes de bases
de datos. Dado que OpenOffice.org está disponible para
diversos sistemas operativos, puede utilizar los mismos datos
en distintas plataformas informáticas.

Para iniciar OpenOffice.org, pulse Alt + F2 e introduzca
OOo, o bien haga clic en el icono Office (Oficina) en el es-
critorio. Para crear un documento nuevo, seleccione Archivo
→ Nuevo y elija el tipo de documento que quiera crear.
Para abrir un documento que ya exista, seleccione Abrir y
elija el archivo adecuado del sistema de archivos.

Visualización de archivos PDF
Los documentos que se deban compartir o imprimir en
distintas plataformas se pueden guardar como archivos PDF
(Portable Document Format, formato de documento
portátil), por ejemplo, en el paquete de aplicaciones
OpenOffice.org. SUSE Linux Enterprise Desktop incluye
varios visores de PDF, como KPDF y Adobe* Acrobat*
Reader.

Para acceder a KPDF o Adobe* Acrobat* Reader:

1. Haga clic en el botón del menú principal.
2. Haga clic en Office → Document Viewer (Oficina - Visor

de documentos). Seleccione Acrobat Reader o KPDF
para abrir el visor de PDF que prefiera. También puede
pulsar Alt + F2 e introducir acroread o kpdf.

3. Para ver un archivo PDF, haga clic en Archivo → Abrir.
Localice el PDF adecuado y haga clic en Abrir.

4. Puede desplazarse por los documentos utilizando los
iconos de navegación que se muestran en las partes
superior e inferior de la ventana. Si el PDF incluye
marcadores, puede acceder a ellos en el panel de la
izquierda del visor.

Búsqueda de datos
KDE proporciona varias aplicaciones que permiten buscar
datos en el equipo o en el sistema de archivos. Con Kerry,
puede buscar fácilmente en su espacio de información
personal (normalmente, la carpeta personal), que se indexa
mediante Beagle. KFind constituye una opción alternativa.

Uso de Kerry
Emplee Kerry para buscar documentos, correos electrónicos,
historial de Web, conversaciones de mensajería instantánea
y de ITC, código fuente, imágenes, archivos de música,
aplicaciones, etc.

1. Pulse F12 para abrir el cuadro de diálogo Kerry Beagle
Search (Búsqueda Beagle con Kerry).
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2. Escriba la cadena de búsqueda en Search (Buscar).
Puede escribir palabras o frases y modificar las opciones
de búsqueda como se describe en las sugerencias que
se muestran en la ventana de búsqueda.

3. Seleccione el ámbito de la búsqueda con la opción
Within (En) que aparece a la derecha.

4. Haga clic en Find (Buscar) para iniciar la búsqueda. Los
resultados aparecerán en la ventana. Utilice los enlaces
de cada resultado para abrirlo directamente o para
mostrar su ubicación en el sistema de archivos con el
gestor de archivos.

Uso de KFind
Para realizar búsquedas básicas y avanzadas, emplee KFind.
Para iniciarlo, seleccione Find Files/Folders (Buscar
archivos/carpetas) en el menú principal o pulse Alt + F2 e
introduzca kfind.

Búsqueda por nombre
Para utilizar un nombre de archivo (o parte de él) como
palabra clave de búsqueda, haga lo siguiente:

1. Escriba el nombre de archivo o parte de él en el campo
de entrada Named (Nombre). Puede utilizar caracteres
comodín, como el asterisco (*) para indicar caracteres
no especificados en el nombre de archivo.

2. Especifique la carpeta en la que desee buscar el archivo.
Puede escribir la vía a la carpeta en Look in (Buscar en),
o bien hacer clic en Browse (Examinar) para localizar la
carpeta.

3. Para buscar en las subcarpetas, marque Include Subfold-
ers (Incluir subcarpetas).

4. Haga clic en Find (Buscar) para iniciar la búsqueda. Los
resultados se muestran en la parte inferior del cuadro
de diálogo. Para abrir un resultado directamente, haga
clic en él. Haga clic con el botón derecho en el resulta-
do para elegir una de las opciones del menú contextual.

Búsqueda por contenido o propiedades
Para realizar una búsqueda más detallada, puede también
especificar otras opciones, como el texto que debe incluir
el archivo o la fecha de creación o modificación.

1. En la pestaña Name/Location (Nombre/Ubicación), es-
pecifique al menos la vía donde buscar el archivo. Puede
dejar en blanco el campo Named (Nombre).

2. Para buscar contenido concreto en un archivo, haga
clic en la pestaña Contents (Contenido). En Containing
Text (Contiene el texto), introduzca la palabra o frase
que debe contener el archivo que está buscando. Esta
opción no funciona con todos los tipos de archivos.

3. Para buscar determinadas propiedades, como la fecha
de creación o de modificación del archivo, haga clic en
la pestaña Properties (Propiedades) y elija las opciones
que desee.

4. Haga clic en Find (Buscar) para iniciar la búsqueda.

Creación de discos CD o DVD
Si cuenta con una unidad de escritura de CD o DVD, puede
grabar archivos en un CD o un DVD con K3b.

1. Pulse Alt + F2 e introduzca k3b. Se abrirá K3b.
2. Haga clic en New Data CD Project (Nuevo proyecto de

CD de datos), en la parte inferior de la ventana.
3. Utilice la vista en árbol de la parte superior izquierda

de la ventana para buscar archivos o carpetas que
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quiera grabar. Cuando se muestren en la parte superior
derecha de la ventana, arrastre y suéltelos en la ventana
Current Projects (Proyectos actuales).

4. Introduzca un CD grabable en el dispositivo y haga clic
en el icono Burn (Grabar).

5. Introduzca la información necesaria en el cuadro de
diálogo Data Project (Proyecto de datos). Si no está
seguro de los ajustes que debe seleccionar, haga clic
en K3b Defaults (Ajustes por defecto de K3b). Estos
ajustes son adecuados para la mayoría de los archivos.

6. Haga clic en Burn (Grabar).

Obtención de actualizaciones de
software
Novell ofrece un flujo continuo de actualizaciones de seguri-
dad de software para sus productos. El applet Software
Updater del panel del escritorio permite aplicar fácilmente
actualizaciones de seguridad con sólo unos cuantos clics.
Cada vez que se conecte a Internet, Software Updater
comprobará automáticamente si hay actualizaciones
disponibles para su sistema en los orígenes que se especi-
fiquen en la configuración de Software Updater.

Para poder usar Software Updater en el sistema, debe reg-
istrar el producto en el servidor de actualizaciones de
Novell. Para ver las actualizaciones disponibles, haga clic en
el icono de Software Updater de la bandeja del sistema.

Determine manualmente las actualizaciones que quiera
aplicar seleccionándolas o anulando la selección en la lista.
Para aplicar las actualizaciones seleccionadas, haga clic en
Actualizar.

Configuración del sistema con YaST
Mientras que el Centro de control de KDE se limita sólo a
la configuración del escritorio KDE, con YaST puede cambiar
la instalación y la configuración de todo el sistema. Por lo
tanto, es preciso contar con permisos de administrador
(Root) para abrir YaST.

YaST incluye distintos módulos que permiten modificar los
ajustes del sistema. Están divididos en las siguientes cate-
gorías:

Software: utilice los módulos de esta categoría para
definir distintas opciones de instalación y actualización o
para instalar y eliminar paquetes de software.

Hardware: utilice estos módulos para configurar el
hardware del equipo, como el monitor, el teclado, el ratón,
la impresora o el escáner.

Sistema: con estos módulos puede cambiar distintos
ajustes del sistema, como la fecha, la hora o el idioma, así
como realizar distintas tareas, como la copia de seguridad
o la restauración de archivos.

Dispositivos de red: emplee estos módulos para config-
urar dispositivos de red, como tarjetas de red, RDSI, DSL o
módem.

Servicios de red: incluye módulos correspondientes a
servicios de red y que permiten configurar distintos clientes,
como LDAP y NFS.

Novell AppArmor: utilice los módulos de esta categoría
para configurar el sistema de seguridad de aplicaciones
Novell AppArmor.

Seguridad y usuarios: con estos módulos puede config-
urar los aspectos relativos a la seguridad, como las opciones
del cortafuegos, así como crear y gestionar usuarios o gru-
pos.

Para abrir YaST, pulse Alt + F2 e introduzca yast. Se abrirá
un cuadro de diálogo en el que podrá introducir la con-
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traseña del usuario Root. Los módulos de YaST ofrecen
documentos de ayuda en línea integrada.

Gestión de impresoras
Las impresoras pueden estar conectadas al sistema local-
mente o proporcionar acceso a través de la red. Para utilizar
una impresora local, asegúrese de que esté conectada al
equipo. Apague el sistema antes de conectar una impresora
que no sea USB.

Puede configurar las impresoras con YaST. Inicie YaST y se-
leccione Hardware→ Impresora en el centro de control de
YaST. De esta forma se abre la ventana principal de config-
uración de impresoras. Según el modelo de impresora local
o de la red, cabe la posibilidad de que YaST la configure
automáticamente. Si la detección automática del dispositivo
de impresión no se produce correctamente, haga clic en
Añadir en el cuadro de diálogo Configuración de impresora
para iniciar el flujo de trabajo de configuración manual.
Siga las instrucciones de la ayuda en línea de YaST. Si no
está seguro de la opción que debe elegir y de la información
que debe introducir, consulte al administrador del sistema.

Cuando haya configurado la impresora correctamente, po-
drá utilizarla desde cualquier aplicación.

Salida de la sesión
Cuando haya terminado de usar el equipo, puede cerrar la
sesión y dejar el sistema en ejecución, o bien reiniciar o
apagar el equipo. Haga clic en el botón del menú principal
del panel y seleccione Log Out (Cerrar sesión). Si quiere
mantener el sistema funcionando, haga clic en End Current
Session (Fin de sesión en curso) en el cuadro de diálogo
que se abre. De lo contrario, haga clic en Turn Off Computer
(Apagar el equipo).

Información adicional
Esta guía proporciona una breve introducción al escritorio
KDE y algunas de las aplicaciones clave que se ejecutan en
él. Para saber más, consulte la guía del usuario de KDE (KDE
User Guide) y otros manuales disponibles para SUSE Linux
Enterprise Desktop en http://www.novell.com/
documentation/sled10/.
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